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/\ CAUTION

The "Safety Precautions" are provided in the User's Guide.
Be sure to read through them prior to use.
After reading this guide, keep it in handy for future reference.




About This Guide

Preface

Thank you for your purchase of a ComColor GL series product.

This guide describes the possible causes and solutions for problems that can occur when using this
machine.

Keep this guide handy, such as near the machine, for easy reference.

The following manuals are included with this machine.

® Quick Guide
This guide describes basic machine operations and how to replace consumables.
Keep this guide handy, such as near the machine, for easy reference.

@ User's Guide
This guide describes handling precautions and specifications, as well as the operations and settings of
each function.
Read this guide for a more detailed understanding of the machine.

@ Administrator's Guide
This guide describes the machine settings and optional equipment to be configured by the administrator.

@ Troubleshooting Guide (this guide)
This guide describes the actions to take when a paper jam or other problem occurs.

About This Guide
(1) This guide may not be reproduced in whole or in part without the permission of RISO KAGAKU
CORPORATION.
(2) The contents of this manual may be changed without prior notice due to product improvements.
(3) RISO KAGAKU CORPORATION shall not be liable for any consequence of using this guide or the
machine.

Trademark Credits

Microsoft, Windows, Windows Server, Internet Explorer, and Microsoft Edge are either registered trademarks
or trademarks of Microsoft Corporation in the United States and/or other countries.

Mac, macOS, OS X, and Safari are trademarks of Apple Inc.

Adobe, the Adobe logo, PostScript, and PostScript 3 are either registered trademarks or trademarks of
Adobe in the United States and/or other countries.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

ColorSet is a trademark of Monotype Imaging Inc. registered in the U.S. Patent & Trademark Office and may
be registered in certain jurisdictions.

FeliCa is a registered trademark of Sony Corporation.

MIFARE is a registered trademark of NXP B.V.

€, ISO, ComColor and FORCEJET are trademarks or registered trademarks of RISO KAGAKU
CORPORATION in the United States and other countries.

Other corporate names and/or trademarks are either registered trademarks or trademarks of each company,
respectively.
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Il Symbols Used in This Guide

A Indicates cautions that should be noted for safe use of this machine.
0 Indicates important items that should be noted or are prohibited.

@ Indicates useful or additional information.

Il Names of Keys and Buttons
The names of the following are indicated with square brackets [ ]:

« Hard keys on the operation panel

« Buttons and items displayed on the touch panel screen
« Buttons and items displayed on a computer window
Example: Press the [Stop] key.

Il Names of Optional Equipment

In this guide, the names of the optional equipment are described using a generic term as shown below.
The specific name for each item of equipment is used when its unique features are explained.

Name Used in This Guide Optional Equipment
Standard Tray High capacity feeder
Stacking tray” Auto-control stacking tray

Wide stacking tray

High capacity stacker

* Optional stacking tray connected to the right side of the machine.

M lllustrations and Operating Procedures in This Guide

» The operating procedures, screenshots, and illustrations in this guide are for the ComColor
GL9730/GL9730R with the optional scanner connected.

» The screenshots and illustrations in this guide may vary depending on the machine model and usage
environment, including the connected optional equipment.
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Touch Panel Display

[Home1] Screen

The touch panel allows you to perform
operations and check the current status of the
machine. Use the information described in this
section to help with troubleshooting.

On the [Home1] screen, press a mode button to access the settings and functions for that mode. You can
check the information described below on each mode button or on the [System Info] screen.

Maintenance System Info

Storage

) §

Maintenance System Info

& |.Smith Idle @ «

1

Maintenance System Info

& J.Smith

When the lock icon is displayed in the top right
corner of the mode button

The lock icon displayed on a mode button indicates

that you must log in to access that mode.

» The administrator configures whether user login is
required for each mode.

When a mode button is grayed out

Buttons for modes that the current user is not

authorized to use are grayed out.

» The administrator configures the mode access rights
for each user.

When a mode button is not displayed

If the administrator sets a mode button to [OFF] in
[Home Screen Customization], that mode button is not
displayed.

* [Admin Menu] is displayed only when the user is
logged in as an administrator.

» Depending on the connection status or settings of
equipment, the buttons for each mode may not be
displayed.

5
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[1] system info You can touch [System Info] on the [Home1] screen to
Frooimeys e gl i) ense e check information about the consumables, machine,
user, and license.

The [Consumables] screen displays the status of the
| Vel ink and paper.

| Thickness | Auto Select.

StdTray | = Standard @ * [User Info] is displayed only when a user is logged

Tray 1 Standard H
4 2 in.

Tray 2 Standard

Tray3 Standard

@« vl vh B
[System Info] screen

Status Area

The information described below is displayed in the status bar on the touch panel.

I (1)User name
The name of the user currently logged in is
displayed.

(2)Printer status

The current status of the machine is indicated with a
description such as [ldle], [Printing], [Error], or
[Some Units Unavailable].

& iT
— - (3 Offline
I This icon is displayed when [Online/Offline] is set to
[OFF]. While the icon is displayed, the machine does
not receive jobs.

(4FORCEJET™ link icon

This icon indicates whether all parts required for

printing are working correctly.

The display will differ depending on the consumable

or configured details.

+ @ (ON): Using RISO ink

e [Z/(ON): Using non-RISO ink (Consumables
information is entered.)

* [Z (flashing): Using non-RISO ink (Consumables
information is not entered.)

For more information on setting the ink information,

see "The [Ink Information Input] screen is displayed.”

(p.57).

(5Remaining ink indicator
The bar of each ink indicates the amount of
remaining ink. When the bar starts flashing, it is the
time to replace the ink cartridge. Prepare a new ink
cartridge for the color that flashes.

» The amount of remaining ink cannot be displayed
when using non-RISO ink. [--] is displayed instead of
the remaining ink indicator.
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Job List Icons

The job list on the [Finished] screen displays the following icons according to the job type along with the

document name/job name.

P
¥—=]ob Status

Close

Active / Document/ Job Name Owner
Idle

(XXXX_33 J.Smith 10:01

Result

Done

Finished

XXXX_31 J.Smith 10:01

Done

XXX _21 J.Smith 10:01

Done

i, |O0O_13 J.Smith 10:01

Done

XXXX_11 J.Smith 10:01

Done

(XXXX_01 J.Smith 10:01

=

DEEEIN0r

R

Icon Job Type
g | Copy job
& | Print job
& | Scan (Mail) job
S | Scan (PC) job
& | Scan (Console) job
= | Storage (Save) job
M |Storage (Load) job
4 |USB (Save) job
§ | USB (Load) job
& | Job with a PIN code
® |PSjob
& | Broken job (Broken data or data with problems)
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Chapter 1 Messages

This chapter describes the reasons why the error LED flashes on the operation panel and messages appear
on the touch panel, and what actions to take.
When the message is displayed, resolve the problem following the instructions in the displayed message.

Operation panel error LED Scanner LED
When an error occurs, the error When an error occurs with the scanner, the scanner LED flashes in
LED flashes in red. red.

ﬁ@g@
= = [O]O i

1A |
| Scanner LED
Error LED

Paper Jam Indication LED
When a paper jam occurs in the multifunction finisher, the panel LED lights up in red.

-
N——

j\f /l/
E1I0[ E1 E2 E3 |2

o@D &

E11| E4 E5 E6 -

HERTRTIE
E12 | E7 E8 E9
[ J | a— | a— | a—

Paper Jam Indication LED
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Error Messages on the Touch Panel

A description of the problem and instructions for resolving the problem are displayed, as shown in the

illustration below.

A problem has occurred.
Turn the power off and on

again with the power key
on the operation panel.
If the problem persists,

contact your dealer.

0 * An alphanumeric error code is displayed at the top of the error message screen.
Be sure to mention this error code when contacting your service representative.
- The first letter of the error code indicates the type of problem.
- The numbers vary depending on the location of the problem.

Examples of the Messages

The following are examples of messages. Follow the instructions in the displayed messages to resolve the

problems.

operation. Touch [Continue] to resume the current operation.

@ « [Cancel] and [Continue] may be displayed on some message screens. Touch [Cancel] to stop the current

<S000-0000>Service Call

These error messages are displayed when inspection or repair is required by a service

representative.
Message

A problem has occurred. Press
the Reset key, or turn the power
off and on again with the power
key on the operation panel. If the
problem persists, contact your
dealer.

Not enough space in memory.
Turn the power off and on again
with the power key on the
operation panel.

Action to Take

A problem has occurred.

Press the [Reset] key on the operation panel. If this still does not
solve the problem, press the [Power] key on the operation panel to
restart the machine. If the above two operations for recovery do not
solve the error, contact your dealer or authorized service
representative. Be sure to mention the error code displayed on the
touch panel when contacting your dealer or authorized service
representative.

The machine cannot be used because there is not enough available
space on the internal solid state drive (SSD).

Press the [Power] key on the operation panel to restart the machine.
If this does not solve the problem, contact your dealer or authorized
service representative. Be sure to mention the error code displayed
on the touch panel when contacting your dealer or authorized service
representative.
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<UO000-0000>Unit Error

These error messages are displayed when repair is required by a service representative.

Message

A problem has occurred on the
standard tray. You can use
another tray to continue printing.

A problem has occurred on the
paper tray (additional tray). You
can use the standard tray
(another tray) to continue
printing.

A problem has occurred on feed
tray 1 (feed tray 2, feed tray 3). To
solve the problem, remove the
jammed paper. You can use
another tray to continue printing.

A problem has occurred on feed
tray 1 (feed tray 2, feed tray 3). To
solve the problem, remove the
jammed paper, and press the
Reset key. Printing using another
tray is possible.

A problem has occurred in the
Additonal tray. Press the reset
key or turn the power of the
control panel off and on. If it
cannot be recovered, please
contact the service provider.

A problem has occurred on the
paper output. You can use
another output tray to continue
printing.

A problem has occurred on the
paper output to the option. You
can use another output tray to
continue printing.

The external controller has an
error. Check.

Action to Take

A problem has occurred with the standard tray.
Touch [Change Tray] and specify a different paper tray.

A problem has occurred with the feed tray.
Touch [Change Tray] and specify the standard tray (another tray) as
the paper tray.

A paper jam occurred in the feed tray.

See "Troubleshooting for the Feed Tray" (p.52), and remove the
jammed paper.

To continue printing with another tray, touch [Change Tray] and
specify a different paper tray.

A paper jam occurred in the feed tray.

See "Troubleshooting for the Feed Tray" (p.52) to remove the
jammed paper, and press the [Reset] key on the operation panel. If
this still does not solve the problem, press the [Power] key on the
operation panel to restart the machine.

If the above two operations for recovery do not solve the error,
contact your dealer or authorized service representative. Be sure to
mention the error code displayed on the touch panel when contacting
your dealer or authorized service representative. To continue printing
with a different paper tray, press the [Reset] key on the operation
panel, change the settings, and send the data.

A paper jam occurred in the additional tray. To continue printing with
a different tray, press the [Reset] key and resume operations. If this
does not solve the problem, contact your dealer or authorized service
representative. Be sure to mention the error code displayed on the
touch panel when contacting your dealer or authorized service
representative.

A problem occurred when paper was output to the face down tray or
face down finisher.
Touch [Change Output Tray] and specify a different output tray.

A problem occurred when paper was output to the multifunction
finisher or stacking tray.
Touch [Change Output Tray] and specify a different output tray.

An error has occurred with the print controller (ComColor Express
FS2100C) or the print controller is not connected properly. Press the
[Reset] key on the operation panel to turn off the display of the error
message and check the LED indicator of the print controller and the
connections of its cables.

11
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<X000-0000>Paper Jam

These error messages are displayed when there is a paper jam.

Message

Buttons indicate paper jam
locations. To display how to fix,
touch the button.

<Y000-0000>Consumable Error

Action to Take

Paper is jammed inside the machine, no paper was fed, or multiple
sheets of overlapped paper were fed into the machine.

Touch the button indicating the location of the paper jam to display
how to remove the jammed paper, and follow the instructions. For
more information, see "Paper Jams" (p.24).

These error messages are displayed when it is time to replace consumables or parts that require

periodic replacement.
Message

Add staples to the Face Down
Finisher.

Punch dust in the finisher is full.
Open the front cover of the
finisher, and dispose of punch
dust.

Open the front cover of the
finisher, and add staples.

Open the front cover of the finisher,
and add staples (front side, back
side) for stapling booklets.

Replace the ink cartridge. Do not
set the removed one to prevent
failure.

The expiration date of the ink
cartridge has expired. Replace the
ink cartridge.

Staple waste in the Finisher is
full. Open the front cover of the
finisher and discard the waste.

Action to Take

There are no more staples in the face down finisher.
See "Replacing the Staple Cartridge" (p.59), and follow the
procedure to replace the staple cartridge.

The punching box becomes full of punching trash. See "Cleaning the
Punching Box" (p.63) and dispose all of the punching trash.

No more staples are left in the multifunction finisher. See "Replacing
the Staple Cartridge" (p.59) and add staples.

Replace the displayed ink cartridge with the new one.
For more information, see "Ink Cartridge Replacement" in the "User's
Guide".

The staple waste box is full of the staple waste. For more information,
see "Cleaning the Staple Waste Box" (p.64).
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<Z000-0000>Installation Error

These error messages are displayed when a cover or tray is not completely closed or an ink cartridge
is not properly installed.

Message Action to Take

Set ink cartridges. No ink cartridge has been installed, or a non-RISO ink has been
installed. Install a RISO ink cartridge, or contact your administrator.

Different color ink is set. Replace The type or color of the installed ink cartridge is not correct. Check
the ink cartridge. the installation position and the color and type of the installed ink
cartridge, and install the ink cartridge properly.

If the wrong ink cartridge has been installed, remove it, wipe the ink
port clean, attach the cap, and store it horizontally in the proper
orientation.

The ink cartridge is not correct.
Replace the ink cartridge.
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Check the Stripper Unit.

The stacking tray of High
Capacity Stacker is not set. Set
the stacking tray.

The stripper unit is not installed properly.

Reinstall the stripper unit.

L TS
Stripper —|
unit T T

3

4

Lower the stripper lock knob (1) to
unlock the stripper unit.

Press the stripper release lever (2))
and remove the stripper unit.

Reinstall the stripper unit.

9 * Make sure that the stripper

unit is fully inserted.

Lift the stripper lock knob to lock the
stripper unit.

When the stripper lock knob cannot
be locked, the stripper unit is not fully
inserted.

Make sure that the stripper unit is
fully inserted.

The stacking tray is not set on the high capacity stacker.
After setting the stacking tray on the carriage, return this to the high

capacity stacker.
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<W000-0000>Warning

These warning messages are displayed when there is no more paper, the output tray is full, a
peripheral device is not connected, or there is another problem.

Message

Set paper.

Auto tray selection is not
available. Select a paper tray, and
press the Start key.

The paper size may not be
correct. Check the standard tray
paper guide, tray, or paper size
setting.

The Standard Tray (Feed Tray 1,
Feed Tray 2, Feed Tray 3,
Additional Tray) is not available.
You can use another tray to
continue printing.

Job name:

This paper size cannot be output
to the specified tray. Change the
output tray or paper size. (The job
was deleted.)

This paper size cannot be output
to the current output tray. Check
the orientation or settings of the
set paper.

This paper size cannot be output
with offset output. Check the
orientation or settings of the set

paper.

There is no tray to which paper
can be output. Remove paper.

An error has occurred on the
scanner.

Action to Take

The paper specified for the job is not loaded in the tray available for
auto selection.

Load the corresponding type and size of paper in the tray available
for auto selection.

Otherwise, touch [Change Tray] and change [Paper Selection] to a
setting other than [Auto], or enable [Auto Selection] for a tray loaded
with the specified paper.

Auto selection is not performed if it is not enabled for any of the trays,
even when paper tray selection is set to [Auto]. Touch [Paper
Selection] and select the tray, or enable [Auto Selection] for the
required tray.

The size of paper specified for the job is not loaded. Load the
specified size of paper. Otherwise, touch [Change Tray] and enable
[Auto Selection] for a tray loaded with the specified paper.

A problem has occurred with the standard tray (with feed tray 1, feed
tray 2, feed tray 3, or the additional tray).

Touch [Change Tray] and specify a different paper tray in which an
error has not occurred.

Touch [Close], change the settings, and send the data again. For
more information on the paper sizes that can be used with each tray,
see "Printing Paper" in the "User's Guide".

Touch [Close], change the settings, and send the data again.
For more information on the paper sizes that can be used with the
output tray, see "Printing Paper" in the "User's Guide".

Touch [Close], change the settings, and send the data again. For
more information on the paper that can be used with offset output,
see "Printing Paper" in the "User's Guide".

The paper output to each tray exceeds the maximum load capacity.
Remove paper.

An error has occurred on the scanner.

Touch [Confirm]. If this message is displayed while scanning an
original, scan the original again.

If the error message does not disappear after touching [Confirm],
press the [Power] key on the operation panel to restart the machine.

15
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Message

Failed to save the scan file.
Check the save destination
setting.

Failed to save the scan file. The
file size exceeds the upper limit,
or the file name exists. Check.

A USB drive is not set. Set a USB
drive, and touch "Retry".

Failed to save to USB drive. The

suspected causes are:

* The number of files, or space
are full.

» Writing to USB drive is not
permitted.

Check.

A file with the same name exists
in the save destination. Do you
want to overwrite?

Failed to send the mail. Check the
mail server setting.

Failed to send the mail. The mail size
exceeds the maximum sending limit.
Change the scan function setting.

Failed to send the mail. The mail
server may malfunction. Check.

Printing on envelopes is
specified. Check whether duplex
printing, finisher settings, or
other settings that cannot be
used in combination are
configured.

Action to Take

The scanned data could not be saved. Check the items below, and
scan the original again.

» Network settings of the destination server

» Problems with the destination server

» Network cable connections

+ [Destination] settings for the scanned data

The scanned data could not be saved.

Touch [Close], and scan the original again.

If a file with the same name already exists, change the file name.

If the file size of the scanned data exceeds the upper limit, reduce the
number of pages in the original, or change the save format.

A USB flash drive is not connected to the machine.

To save to a USB flash drive, connect it to the machine, and touch
[Retry]. To cancel saving to the USB flash drive, touch [Cancel].

To save to the internal SSD of the machine, touch [Save to Internal
SSD].

You attempted to save the file using a file name that already exists on
the USB flash drive.

Touch [Close] or [Cancel] and change the file name, or touch [Save
to Internal SSD] to save the file to the internal SSD of the machine.

There is not enough space in the USB flash drive.

Either change the destination to the internal SSD of the machine, or
delete unnecessary data from the USB flash drive to free up enough
space, and then save the data again.

The USB flash drive is set to write protected.

Touch [Close] or [Cancel] to cancel saving to the USB flash drive, or
touch [Save to Internal SSD] to save the file to the internal SSD of
the machine.

You attempted to save the file using a file name that already exists on
the USB flash drive.

Touch [Continue] to overwrite the existing file. To change the file
name and save, touch [Cancel] and save the file again.

The scanned data could not be sent by mail. Check the following.

* Mail server setting

* Mail server problems

* Network cable connections

For more information on the mail server setting, see "Mail Setting" in
the "Administrator's Guide".

Or contact your mail server administrator.

Incompatible settings for the envelope job have been specified.
Cancel the following settings, and send the data again.

* Duplex printing

» Functions specified on the multifunction finisher

In a state where [Thickness] for the type of paper is set to [Envelope],
you are trying to print on paper other than an envelope. Touch
[Change Tray] and change [Thickness] to [Standard].
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Message

A file containing a large amount
of data is still processing. Press
"Continue™ button to allow
processing to finish, or press
"Cancel" button to delete the job.

Not enough space in SSD. Delete
unnecessary jobs to free up
space in SSD.

Job name:
This job has been deleted.

Job name:

This job cannot be executed.
Check the data type. (The job was
deleted.)

The time of the Kerberos server
may not be synchronized with
that of the printer.

This is Non-Riso ink cartridge.
Using Non-Riso ink may result in
serious damage to the printer.
Check your service provider's
warranty/service agreement if
any, as damage caused by Non-
Riso supplies could be excluded
from coverage. Do you wish to
continue using this cartridge?

The staple unit (punch unit, top
tray unit, stacking tray unit,
booklet tray unit, tri-fold output
tray unit) of the finisher is not
connected. Check. (The job was
deleted.)

Failed to lower the Stacking Tray.
Check the tray of the finisher.

Job name:

Cannot print due to failure of the
staple unit (punch unit, top tray,
stacking tray, booklet unit, tri-fold
output tray) of the finisher.
Printing without using the staple
unit (punch unit, top tray,
stacking tray, booklet unit, tri-fold
output tray) is possible. (The job
was deleted.)

Action to Take

A job with a large amount of data is being processed.
When a job contains a large amount of data, it is recommended that
you handle it as a waiting job or save it to storage before printing.

The SSD of the machine is full.
Delete completed jobs or unnecessary documents in storage to free
up space on the solid state drive.

The corresponding job was deleted on the RISO Console while it was
suspended.
Send the data again.

The specified job cannot be printed because the file is used by the
Barcode Area Definition Software.

There is a time difference between the machine's internal clock and
the Kerberos server. Contact your administrator.

The time can be synchronized by using [NTP Time Synchronization]
in [Admin Menul].

A non-RISO ink cartridge has been installed.

Contact your administrator to determine whether or not to use this
ink. To continue using the non-RISO ink cartridge, touch [Yes] and
enter the appropriate values in the [Ink Information Input] screen
which appears next. For more information, see "The [Ink Information
Input] screen is displayed." (p.57).

Each unit (staple unit, punch unit, top tray unit, stacking tray unit,
booklet tray unit, tri-fold output tray unit) of the multifunction finisher
is not connected. Contact your dealer or authorized service
representative.

Something may be obstructing the stacking tray. Make sure that
nothing is placed below or near the tray.

Each unit (staple unit, punch unit, top tray unit, stacking tray unit,
booklet tray unit, tri-fold output tray unit) of the multifunction finisher
cannot be used. Contact your dealer or authorized service
representative. If you touch [Close], you can continue using the
machine except for the unit that has an error.
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Message

Job name:
Paper size that cannot be output

with the Z-fold setting is included.

Check the print data. (The job
was deleted.)

This paper size cannot be output
with the current paper fold
setting. Check the orientation or
settings of the set paper.

This paper size cannot be output
with the current booklet setting.
Check the orientation or settings
of the set paper.

This paper size cannot be output
with the current staple/punch
setting. Check the orientation or
settings of the set paper.

Check the auto-control stacking
tray.

Paper is not appropriately loaded
in the stacking tray of High
Capacity Stacker. Check the
stacking tray.

Paper is left in the High Capacity
Stacker. Print cannot be run.
Remove paper from the stacking
tray.

Mixed size paper is stacked in the
High Capacity Stacker. Remove
paper from the stacking tray.

Job Name:

This job cannot be ejected in the
stacking tray of High Capacity
Stacker. Check the settings. (The
job has been deleted.)

Action to Take

A size of original that cannot be used with [Mixed Size Z-fold] is
included. [Mixed Size Z-fold] can only be used with the combinations
of A4 and A3, B5 and B4, and Letter-LEF and Ledger. Check the
original size.

Touch [Close], and change the settings.

For more information on the paper sizes and orientations that can be
used when folding the paper, see "Fold" or "Booklet Binding" in the
"User's Guide".

Touch [Close], and change the settings. For more information on the
paper sizes and orientations that can be used when creating
booklets, see "Booklet" in the "User's Guide".

Touch [Close], and change the settings. For more information on the
paper sizes and orientations that can be used when stapling, see the
following.
* When using the face down finisher

"Staple" of the "User's Guide"
* When using the multifunction finisher

"Staple / Punch" of the "User's Guide"

The guides of the auto-control stacking tray are not properly set.
Check.

The paper guides of the high capacity stacker are not set in their
proper positions and the paper is not aligned. Check the printouts.
To output irregular sized paper, it is necessary to register the paper
size to the machine in advance. Contact your administrator for
details.

There is paper on the stacking tray of the high capacity stacker.
When there is paper on the stacking tray, the paper guides cannot
move to the appropriate positions for the next job. Remove paper.

0 * When the power is turned on or when recovering from
the sleep mode, it is necessary to remove the paper on
the stacking tray as otherwise the paper guides will not
be able to move to their appropriate positions in
accordance with the paper size. If you are not removing
the printouts every time a print job is completed, it is
recommended that the time until entering the sleep mode
be set longer with [Power Saving Setting] in the
administrator menu.

For more information on the power saving setting, see
"Power Saving Setting" in the "Administrator's Guide".

The printouts do not come out as the job contains inappropriate
settings for the high capacity stacker (paper size, mixed size
originals, or containing settings that cannot be performed). Change
the output tray, specify the paper size that can be output, or change
the settings so that the sizes are not mixed.

ComColor GL Series Troubleshooting Guide



Message

The High Capacity Feeder is
overloaded with paper. Check the
feed tray.

Load paper in High Capacity
Feeder or check the paper guides
and paper size settings.

The data including the following
settings cannot be used with
Overlay.

The Standard Tray (Feed Tray 1,
Feed Tray 2, Feed Tray 3,
Additional Tray) is not available.
(The job has been deleted.)

IP address of LANO and LAN1, or
network segment may be
conflicting. Please check the
network settings of LANO and
LAN1.

Action to Take

Paper that exceeds the maximum number of sheets that can be
loaded has been loaded in the high capacity feeder. Remove paper.
For more information on the maximum number of sheets that can be
loaded, see "Printing Paper" in the "User's Guide".

Load the paper in the high capacity feeder.

The standard tray paper guides do not match the size of the paper.
Match the standard tray paper guides with the size of the paper.
Otherwise, touch [Change Tray] and check the paper settings.

Overlay cannot be used if the selected overlay image contains the
following settings. Touch [Close], cancel these settings, and save the
data in the storage again.

* Reproduction Size

* Duplex

 Staple / Punch

« Combine

* Image Repeat

* Booklet

* Booklet Binding

* Fold

* Mixed Size Original

 Processing Speed Priority (Image Quality)

* Program

+ Add Cover

» Auto Image Rotation

A problem has occurred with the standard tray (with feed tray 1, feed
tray 2, feed tray 3, or the additional tray) in which the slip sheets or
cover sheets are loaded. Touch [Close], check the standard tray
(feed tray 1, feed tray 2, feed tray 3, or the additional tray), and send
the data again.

The same IP address (segment) is set to LANO and LAN1 of the
machine. When assigning the IP addresses manually, assign a
different IP address to LANO and LAN1.

Check the IP address from [Network Setting (IPv4)] or [Network
Setting (IPv6)] in [Admin Menul].
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<1000-0000>Information

These messages are displayed when machine maintenance is required.

Message

The drain tank must be replaced
soon. Contact your dealer, and
have a new drain tank ready.

The transfer belt is dirty. Leaving
the belt dirty results in inaccurate
printing. Contact your dealer.

Parts of the Face Down Finisher
need to be replaced. Contact your
dealer.

Ink cartridge is near expiration. It
is recommended to use or
replace the ink cartridge soon.

Action to Take

The drain tank needs to be replaced. Contact your dealer or
authorized service representative.

0  Printing cannot be performed when the drain tank is full.
Call for service immediately when this message is
displayed.

The transfer belt needs to be cleaned. Contact your dealer or
authorized service representative.

9 * The paper size and position cannot be detected when the
transfer belt is dirty, resulting in improper printing.
The cleaning operation needs to be performed by
technical support staff. Call for service immediately when
this message is displayed.
Until the transfer belt is cleaned, the margins around the
edges of the paper are 5 mm (7/32"), regardless of the
printable area setting.

Contact your dealer or authorized service representative. If you touch
[Close], you can continue using the machine functions except for the
face down finisher. Printing can be performed using a different
stacking tray.

For optimal printing quality, use the ink cartridge within approximately
24 months from the date of manufacture (when preserved under
room temperature).
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Chapter 2  Troubleshooting

This chapter describes what actions to take when problems occur.
Use the information in this chapter to help with troubleshooting.

Problem See

Paper Jams p.24
General Troubleshooting for This Machine
The machine does not operate at all. / Nothing is displayed on the touch panel when the power
is turned on. P32
Nothing is displayed on the touch panel, even when the buttons of the operation panel are
touched. p-32
The scanner does not operate. p.32
The printing results are light or dark. p.32
When copying or scanning, the original loaded in the ADF (automatic document feeder) is not
fed properly. p-33
Prints or copies have white streaks or appear blurry. p.33
The output results are dirty or have black streaks. p.33
The copied or scanned data is blurred, or part of the data is not printed. p.34
The back of the original is visible. p.34
Moire interference occurs. p.34
The paper becomes dirty. / Printing is not aligned properly. p.34
No paper is fed. / The back of a card is damaged. / Multiple sheets of paper are fed. p.35
A multiple feeding error occurs although multiple sheets of paper were not being fed, or multiple
feeding errors occur frequently. p-36
Troubleshooting for the Printer Driver and Printing
Cannot print from a computer. p.37
Cannot print properly on irregular sized paper. p.37
\SIYheen printing a document with multiple pages, some pages are printed with an incorrect paper 0.37

ize.
It takes a long time to print. / When printing multiple copies, the printer makes a beep sound
after each copy is printed. p-38
The PIN code for a job is lost. p.38
[Full Color] and [Auto] are not displayed in the [Color Mode] menu on the printer driver screen. | p.38
The items of [Staple] and [Output Tray] on the printer driver screen cannot be selected. p.38
Cannot specify pages to print. p.38
Only one copy (page) is printed even though multiple copies (pages) are specified. p.38
Part of the image is missing. p.38
Cannot reprint a job on the [Job Status] screen. p.38
After interrupting a job or turning the machine off and back on, it is unknown how much printing
was completed. p-39
Paper is loaded but the "Set paper." error message is displayed. p.39
The results of color printing are poor. p.39
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Problem See
Printed images are light or faded. p.39
The paper edges become dirty. p.39
Images are bright or dark. p.39
Duplex printing cannot be performed using the paper loaded in the standard tray. p.40
The sent data became a broken job. p.40
The colors of a barcode background or nearby images cannot be printed out. p.40
The layout order is not correct. p.40
When the imposition is specified, the page numbers are not stamped on both sides of paper. p.40
Part of the original (image) is missing in the formed poster. p.40
Part of the poster is formed with one or more blank pages. / The printed image of the poster is
not formed at the center. p-40
Cannot properly stick the sheets of printed paper to form a poster. / Failed to cut along the
cutting lines (register marks). p-41
Cannot properly stick the sheets of printed paper to form a poster. p.41
Troubleshooting for Copying
Part of the original is missing in the copied data. p.42
Duplex copying was performed, but the back of one or more pages is blank. p.42
Duplex copying cannot be performed for the paper loaded in the standard tray. p.42
Cannot collectively copy multiple originals as one job. p.42
The paper is stapled at the wrong position. p.43
Troubleshooting for Scanning
There is no scanned data on the scan screen of the RISO Console. p.44
Part of the original is missing in the scanned data. p.44
The color mode is set to [Auto], but the machine does not identify color originals automatically. |p.44
The scanned data cannot be saved on a computer on the network. p.44
Troubleshooting for Storage and USB
Files saved on a USB flash drive are not displayed on the printer. p.45
Cannot print properly on irregular sized paper. p.45
Paper is loaded but the "Set paper." error message is displayed. p.45
The results of color printing are poor. p.45
Duplex printing cannot be performed using the paper loaded in the standard tray. p.46
Part of the original is missing in the copied data. p.46
Part of the original is missing in the scanned data. p.46
The color mode is set to [Auto], but the machine does not identify color originals automatically. | p.46
Troubleshooting for the Multifunction Finisher and Face Down Finisher
The multifunction finisher or face down finisher does not operate. p.47
When you copy the original, the paper is stapled at the wrong position. p.47
Staples do not penetrate well, e.g., they bend or crush. / Paper is not output from the face down 047

finisher.
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Problem See
A staple is jammed inside the machine. p.47
Sheets come out loosely stacked on the face down finisher. / Printouts are curled back. p.47
Troubleshooting for the Feed Tray
Paper is jammed in the feed tray. / The tray cannot be pulled out smoothly. p.52
Troubleshooting for the High Capacity Feeder
Although the paper in the high capacity feeder has run out, the standard tray does not descend
to its lowermost position and stops midway. p-53
The paper feed guides cannot be adjusted and cause the paper to bend, warp, or be
misaligned. P53
Troubleshooting for the High Capacity Stacker
The stacking tray does not descend and it is difficult to remove the printouts. p.54
The stacking tray descends each time a job is printed and it is not possible to continuously print. | p.54
Troubleshooting for the IC Card Reader
Unable to log in using the IC card. p.55
A registered IC card is lost or missing. p.55
Other Problems
The front cover does not open. p.56
The correct user name is not displayed when touching the index button on the [Login] screen. p.56
A job with a PIN code cannot be deleted. p.56
The printer does not wake up automatically. p.56
The RISO Console screen is not displayed. p.56
Some mode buttons are not displayed on the RISO Console screen. p.56
How can | add paper during printing. p.56
Cannot print from a computer when using external server authentication. p.56
Cannot change the settings of the feed tray. p.57
Cannot download the firmware. p.57
The [Ink Information Input] screen is displayed. p.57
Troubleshooting for the Optional PS Kit
Files saved on a USB flash drive are not displayed on the printer. p.58
It takes a long time to print when using Mac OS. / Printing cannot be performed with the current
settings. p.58
When using Mac OS to print a document with multiple pages, some pages are printed with an
incorrect paper size. p-58
When printing a PDF file directly from a USB flash drive, a paper with the texts "Implementation 0.58

limit exceeded" is printed out.

PS Kit FG10 is not supported in some regions.
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Paper Jams

If a paper jam occurs in the machine or optional equipment, printing stops, the error LED on the operation
panel flashes in red, and the paper jam location is displayed on the touch panel. Follow the procedure
displayed on the touch panel to remove the jammed paper and resume printing.

ACAUTION

Be careful of protruding parts and metal terminals when inserting your hand in the machine, such as
when removing jammed paper. Otherwise, an injury might occur.

» For more information on how to troubleshoot the problem when a paper jam occurs in the ADF (automatic
document feeder), see "When copying or scanning, the original loaded in the ADF (automatic document feeder)

is not fed properly." (p.33).

1 Touch the button indicating the location of the paper jam to display how to
remove the jammed paper.

Buttons indicate paper jam locations. To
display how to fix, touch the button.

2 Follow the procedure displayed on the touch panel to remove the paper.

Touch [Back] or [Next] to display the previous or next page.
The screenshots below are examples of the display when there is a paper jam.

Pull [G] to open T Remove the S Ifitis diff Turn [G] clockwise,
1 the Cover [G]. 2Jammed paper : 3 to remove, open 4and remove paper
from [G]. the front cover. from the opening
[G].
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3 Touch [Close].

Return to the screen in Step 1. Check that the button indicating the location where the paper was removed has
disappeared.

When all of the jammed paper is removed and the cover is closed, the error screen closes and the previous screen
is displayed.

0 * As long as alphabet buttons are displayed on the screen, paper still remains in the indicated
locations. Repeat Steps 1 to 3 to remove the jammed paper.
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Precautions When Removing Jammed Paper

» Slowly and carefully remove the jammed paper. Be careful not to leave pieces of paper in the machine.

« If a paper jam occurs when printing multiple sheets of paper, the sheet of paper that caused the paper jam
as well as other sheets of paper may remain in the transfer path. When using an internal dial to remove
jammed paper, turn the dial four or five times after removing the first sheet of paper, to check for other
sheets of paper.

» Depending on the jammed locations, it may be easier to remove the jammed paper if you roll up the paper
little by little.

* For returning the drawer of the location [Y] to its original position, insert the drawer into the far end of the
tray and hold down the handle until you hear a click (as shown with the arrow @ below). The drawer is
fixed when it is fully inserted.

Example of how to remove jammed paper at location [Y]

* You can pull out the paper removal opening (as shown in the figure below) only when a paper jam occurs.
» The print heads are located inside the top of the paper removal opening. When removing jammed paper

from the opening, avoid touching the print heads to prevent ink from getting on your hand or sleeve.
 Dial "C2" is used when the stacking tray is connected to the right of the machine.

Paper removal opening C2

26

ComColor GL Series Troubleshooting Guide



Frequent Paper Jams

If paper jams occur frequently, check the points listed below again.

» The paper on the standard tray or in the feed tray is within the maximum load capacity.
» The paper guides and stopper are positioned correctly, and paper is loaded properly.
Example of how to set the feed tray:

» The machine detects the size of the paper based on the stopper and paper guides position. Be sure to move the
guides and stopper against the edge of paper

* Do not place anything such as spare paper on the paper size detection sensor when loading A4 or A5 size
paper. If the sensor is blocked, the machine cannot detect the paper size correcitly.

J

\ =

» The paper that is actually loaded matches the settings of [Paper Selection] - [Paper Tray Setting].

ﬁ » Some settings such as the timing to feed paper are adjusted to suit the selected paper thickness.

» Usable paper is loaded.
In particular, wrinkled or curled paper can cause paper jams, so do not use this type of paper.

* When using irregular sized paper, the paper size must be registered in advance in the administrator menu.
Contact your administrator. To use unregistered irregular sized paper, select [Paper Selection] - [Paper
Tray Setting] - [Paper Size], and specify the size in [Manual].
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* When using paper that has already been printed on one side or is dark in color, the machine may
incorrectly detect a single sheet as if it were multiple sheets of paper being fed. Set [Double-feed Check]
to [OFF].

[Print] screen » selectjob P [Change Setting] in the sub menu » [Paper Selection] » [Paper Tray
Setting] » set [Double-feed Check] to [OFF]

[Storage] - [Load] screen » select folder » select document » [Change Setting] in the sub menu for
the document » [Paper Selection] » [Paper Tray Setting] » set [Double-feed Check] to [OFF]

[USB] - [Load] screen P select folder » [Open] » select document » [Change Setting] in the sub
menu > [Paper Selection] » [Paper Tray Setting] » set [Double-feed Check] to [OFF]

[Copy] screen P [Paper Selection] » [Paper Tray Setting] » set [Double-feed Check] to [OFF]

[Storage] - [Save] screen P select folder » [Save Document] P [Paper Selection] » [Paper Tray
Setting] » set [Double-feed Check] to [OFF]

[Home1] screen » [System Info] » [Paper Tray Setting] » set [Double-feed Check] to [OFF]

0 * Return [Double-feed Check] to [ON] after printing. If you leave [OFF] as is, other problems might
occur.

» For more information on how to load paper and the types of paper that can be used, see "Loading the Paper"
and "Printing Paper" in the "User's Guide".
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This section describes the path that paper

Pa per Feed Path travels through the machine during printing.
See this information when removing jammed
paper from the machine.

During printing, paper travels through the machine as shown in the illustration below.

sl Solid line: Paper feed path during simplex printing
====o Dashed line: Paper feed path during duplex printing

<When using the face down tray> <When using the face down finisher>

R

\*‘ﬁ """" \. N \nﬁ - ------- ‘
* 1 ‘\ 1
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<When using the multifunction finisher>
The paper feed path inside the multifunction finisher is the same for simplex printing and duplex printing.

Top Tray
s Stacking Tray
AN : i
O P —— - ' '
N ~ -‘/’ \ 1 l
> 1 ' |
- AN
T~ =% ' |
— [ % Booklet Tray

'@ L J

O O O OO0 OO O

Tri-fold Output Tray

» The tray to which the printed materials are output will differ depending on the configured functions of the
multifunction finisher.

» For more information on the paper feed path when the multifunction finisher is connected, see the next
page.
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When connected to the
multifunction finisher
The following describes the paper feed path when

outputting printouts face up with both simplex and
duplex printing.

When stapling

O OO0 OO0 O
Staple

When punching

Punch

O OO0 OO0 O

When stapling and punching

Punch

When booklet binding/bi-folding

O O‘ O O‘ O O
Booklet / 2-fold

When the folder unit is added
When tri-folding

When Z-folding

L

O O|_) (O] O
Z-fold
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General Troubleshooting for This Machine

This section describes how to troubleshoot general problems that may occur in the different modes.

» Make sure that the main power switch is turned
on.

» Make sure that the power plug of the machine is
properly inserted into the electrical outlet.

* Make sure that the power cord is securely
connected to the machine.

* Make sure that the power breaker has not been
tripped.

The machine may be in sleep state.

If you leave the machine unattended for some
time, it automatically enters sleep state according
to the administrator settings. Press the [Wake Up]
key.

» Make sure that the power plug of the scanner is
properly inserted into the electrical outlet.

» Make sure that the USB cable is securely
connected to the printer and scanner.

The density setting may not be configured
properly.

For printing:

Adjust the [Print Density] setting in the [Image] tab
on the printer driver screen.

For copying and scanning:
Configure the [Scanning Level] setting for copying
according to the original.

[Copy] screen / [Scan] screen P [Scanning
Level]

[Storage] - [Save] screen / [USB] - [Save] screen
> select folder » [Save Document] »
[Scanning Level]

If you are printing or copying, the paper
type setting may not match the type of
paper loaded in the standard tray or feed

tray.
Correctly configure the paper type.
For printing:

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Type]

[Storage] - [Load] screen » select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » [Paper Type]

[USB] - [Load] screen » select folder » [Open]
» select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » [Paper Type]

For copying:

[Copy] screen P [Paper Selection] » [Paper
Tray Setting] » [Paper Type]

[Storage] - [Save] screen P select folder »
[Save Document] » [Paper Selection] »
[Paper Tray Setting] » [Paper Type]
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The original may be too small.

The minimum size original that can be loaded in
the ADF is 100 mm x 148 mm (3 15/16" x 5
27/32"). If the original is too small, it may not be
fed properly from the ADF, causing a paper jam.
Load originals smaller than 100 mm x 148 mm (3
15/16" x 5 27/32") on the platen glass.

ﬁ » Even if the size of the original is appropriate, the
paper thickness, type or other characteristics

may prevent it from being scanned with the
ADF. For more information, see "Originals" in
the "User's Guide".

Try the following if the paper jammed in the
ADF (automatic document feeder) cannot
be removed.

« If you find a jammed paper when opening the
original unit cover, turn the blue dial on the side
to make paper removal much easier.

* If you cannot find a jammed paper even when
opening the original unit cover, check the inside
of ADF (automatic document feeder). Turn the
blue dial on the underside in the right direction to
transfer the jammed paper to the ejection part
where you can easily remove it.

The print heads may be clogged.
Perform [Print Head Cleaning] to unclog the print
heads.

[Home1] screen » [Maintenance] » [Print
Head Cleaning] » [Normal Cleaning]

If this does not fix the problem, perform [Strong
Cleaning].

Paper that is unusable for printing or copying
may have been loaded in the machine.

Check the type of the paper loaded in the standard
tray or feed tray. For more information, see
"Printing Paper" in the "User's Guide".

You may be using curled paper for printing or
copying.

Curled paper can come in contact with the print
heads, causing the paper to become dirty. This can
damage the print heads, so do not use curled
paper.

If you are copying or scanning, the [Scanning
Level] setting may be too dark.

Adjust the [Scanning Level] setting.

[Copy] screen / [Scan] screen » [Scanning
Level]

[Storage] - [Save] screen / [USB] - [Save] screen
> select folder » [Save Document] »
[Scanning Level]

If you are copying or scanning, the original
cover may not have been closed securely.
Close the original cover of the scanner securely to
prevent any light from entering.
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If you are copying or scanning, the parts listed
below may be dirty.
Wipe them with a soft cloth.

Scanner glass
(Upper)

White sheet

Scanner glass
(Lower)

Platen glass

@ « Any dust, debris, ink, glue, or correcting fluid
adhering to the white sheet of the ADF, the

platen glass, or scanner glass can result in the
copied or scanned data that is not clean.
Perform periodic cleaning. For more
information, see "Scanner Care" in the "Quick
Guide".

The original may not be in complete contact
with the platen glass.

Close the original cover so that the original is
completely flat against the platen glass.

The scanner may have been subjected to
vibration.

Scan the original again without subjecting the
scanner to vibration.

If you are copying, the paper may be moist.
If the paper contains moisture, part of the copied
data may not be printed or it may be blurred. Use

dry paper.

If you are copying or scanning an original on
thin paper, the image on the back side of the
original or on the next page may be captured in
the image data.

* Adjust [Scanning Level] to a lighter setting.

[Copy] screen / [Scan] screen P [Scanning
Level]

[Storage] - [Save] screen / [USB] - [Save]
screen P select folder » [Save Document]
» [Scanning Level]

» Place a black piece of paper on the back side of
the original and copy or scan the original again.

* When copying or scanning an original with a
base color, such as a newspaper or magazine,
you can use the [Base Color Level] setting to
adjust the base color level.

[Copy] screen / [Scan] screen » [Base Color
Level]

[Storage] - [Save] screen / [USB] - [Save]
screen P> select folder » [Save Document]
> [Base Color Level]

Moire interference (meshed shadow) can easily
occur when copying or scanning images such
as photographs that have been subjected to
screen processing for publication.

Moire interference can be reduced by configuring
the [Moire Elimination] setting.

[Copy] screen / [Scan] screen » [Image Control]
» [Moire Elimination]

[Storage] - [Save] screen / [USB] - [Save] screen
> select folder » [Save Document] » [Image
Control] » [Moire Elimination]

The paper may be too dark for printing.

When printing on dark colored paper, the machine
may not be able to detect the paper size, resulting
in misaligned printing, image loss, or soiled paper
edges.

The paper size may not be set properly.

For the paper size setting, make sure that the
[Paper Size] and [Paper Type] settings on the
printer driver screen match the corresponding
settings on the machine.
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Configure the same paper size and type settings
on the machine as those on the printer driver.

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Size] or [Paper Type]

The [Thickness] setting in [Paper Type] may
not match the paper properties (paper
thickness).

Correctly configure the [Thickness] setting in
[Paper Type].

For printing:

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Type] » [Thickness]

[Storage] - [Load] screen » select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » [Paper Type] »
[Thickness]

[USB] - [Load] screen » select folder » [Open]
» select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » [Paper Type] » [Thickness]

For copying:
[Copy] screen P [Paper Selection] » [Paper
Tray Setting] » [Paper Type] » [Thickness]

[Storage] - [Save] screen P select folder »
[Save Document] » [Paper Selection] »
[Paper Tray Setting] » [Paper Type] »
[Thickness]

For more information, see "Paper Selection" in the
"User's Guide".

The paper feed pressure may need to be
adjusted to suit the paper thickness.

Set the paper feed pressure adjustment lever to
"% (NORMAL)" or "8 (CARD)" based on the type
of paper that is loaded.

Normally, set the lever to " (NORMAL)". If paper
feeding is a problem, set this to "5 (CARD)".

For more information, see "Loading the Paper in
the Standard Tray" in the "User's Guide".

The angle of the stripper plate may not be
properly adjusted.

Turn the stripper plate angle adjustment dial to
adjust the angle of the stripper plate to suit the
conditions.

When no paper is fed:
Turn the dial gradually to the left and adjust the
angle to a proper angle.

When multiple sheets of paper are fed:
Turn the dial gradually to the right and adjust the
angle to a proper angle.

0 * When adjusting the angle, be sure to
remove the paper from the standard tray
and lower the standard tray all the way to
the lowest position.
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The paper separation pressure may not be

properly adjusted.

When no paper is fed, the back of a card is

damaged, or paper that can easily generate
paper powder is used:

Turn the dial to "A little weak".

Strong \ Wﬁ
Standard Weak ArE

)

@
1)
%

L\ES

A I|ttIe weak

When multiple sheets of paper are fed:
Turn the dial to "Strong".

Strong 1L | WE
- H 8
Standard \A\ <
- eak s\Q

A little eak

ZU

9 * When adjusting the angle, be sure to
remove the paper from the standard tray
and lower the standard tray all the way to
the lowest position.

You may be using dark colored paper or paper
that is printed on one side.

When using paper that is printed on the back or
paper with a dark base color, the machine may
incorrectly detect this type of paper as if it were
multiple sheets of paper being fed. In this case, set
[Double-feed Check] to [OFF].

9 « Return [Double-feed Check] to [ON] after
printing. If you leave [OFF] as is, other
problems might occur.

For printing:

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » set [Double-feed Check] to
[OFF]

[Storage] - [Load] screen » select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » set [Double-feed Check]
to [OFF]

[USB] - [Load] screen » select folder » [Open]
> select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » set [Double-feed Check] to [OFF]

For copying:

[Copy] screen » [Paper Selection] » [Paper
Tray Setting] » set [Double-feed Check] to
[OFF]

[Storage] - [Save] screen P select folder »
[Save Document] » [Paper Selection] »
[Paper Tray Setting] » set [Double-feed Check]
to [OFF]
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Troubleshooting for the Printer Driver and Printing

This section describes how to troubleshoot problems related to the printer driver and printing.

The [Online/Offline] setting may have been set
to [OFF].

Check the [Online/Offline] setting on the [Print]
screen.

If [OFF] is displayed, switch it to [ON].

[Print] screen » set [Online/Offline] to [ON]

You may be using a printer of which the
network segment is different.

Select the [Wake On LAN] and [Connect to
Another Network] check boxes in the
[Environment] tab of the printer properties.

& Properties X
General Shsring Forts Advanced Color Mansgement Security Environment

[[]via Shared Printer
IP Address of the Printer:

[]5MMP Community Name

o
[l wake On LaN
MAF Addrace nF tha Drintar: |00 ‘ | 00 1 o0 | |oo 00 00

Printer Configuration

The job may be a waiting job.

Jobs with a PIN code are handled as waiting jobs.
The administrator may have configured the
machine to handle all jobs as waiting jobs.

Check whether the job is displayed in [Waiting Job
List] on the [Print] screen.

The machine may be busy printing another job.

* Idle jobs are printed in order from the top of the
list on the [Active/ldle] screen.

* When the interrupt copy function is performed,
the copy job has priority over the jobs sent from
the printer driver.

Is the ink cartridge replacement message being
displayed?

You cannot print if the message shows that even
one color needs to be replaced. Replace the ink
cartridge of the color shown.

The irregular sized paper may not have been
registered.

The paper size must be registered in advance in
[Custom Paper Entry] on both the printer driver
and the machine.

Printer driver properties screen » [Environment]
tab » [Custom Paper Entry]

The paper size must be registered in advance in
the administrator menu on the machine by the
administrator. Contact your administrator.

[Manual] may not have been selected for [Paper
Size] in [Paper Selection] - [Paper Tray Setting].
To use irregular sized paper without registering it
as a paper size, enter the size of the paper in
[Manual].

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Size] » [Manual]

@ * When [ON] is not selected for [Manual], the
width and length of the paper size configured
with [Paper Size] of the printer driver will be
applied. When you use the irregular sized
paper, registering the paper size beforehand will
improve the print speed and paper alignment.

The original data may include pages with
different paper sizes.

Select the [Mixed Size Original] check box in the
[Basic] tab on the printer driver screen. The paper
tray is automatically selected according to the
original size, and the document is printed.
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The [Collate] check box may have been
selected in the [Print] dialog box of the
application.

Remove the check mark from [Collate] before
printing.

If you lose the PIN code, printing cannot be
performed.

Add a new PIN code and send the data again.
Contact your administrator to delete the job
remaining in [Waiting Job List] on the [Print]
screen.

The color printing function may be restricted.
Contact your administrator.

The following optional equipment in the
machine may not be connected.

» For [Staple]: Face down finisher or multifunction
finisher

» For [Output Tray]: Auto-control stacking tray,
wide stacking tray, high capacity stacker, or
multifunction finisher

The optional equipment configuration
information on the printer drive screen may not
have been set.

To set the optional equipment configuration
information, click [Get Printer Info] on the printer
driver screen.

Printer driver properties screen » [Environment]
tab > [Get Printer Info]

@ * You can also set the optional equipment
configuration information manually. For more

information, see "Printer Configuration" in the
"User's Guide".

The [Collate] check box may have been
selected in the [Print] dialog box of the
application.

Remove the check mark from [Collate], and set
[Sort] to [Uncollated] in the [Basic] tab on the
printer driver screen.

[Print and Pause] may have been set.

If [Print and Pause] has been set on the printer
driver screen, printing stops after one copy (page)
is printed. If there is no problem with the print
result, press the [Start] key on the operation panel
or touch [Continue] on the touch panel to continue
printing. To cancel [Print and Pause], remove the
check mark from the [Print and Pause] check box
in the [Basic] tab.

When creating a booklet or performing [Staple],
the [Auto Reduction] setting may not have
been configured.

When creating a booklet or using the staple/punch
function, depending on the width of the margin, the
printed surface may be cropped due to not fitting
on the paper. In the [Finishing] tab on the printer
driver screen, select [Booklet Binding] or [Binding
Edge] and click [Details]. Select the [Auto
Reduction] check box to automatically reduce the
printed surface so that it will fit on the paper.

Reprinting of the job may be restricted.

When reprinting of jobs is restricted in the
administrator menu, reprinting cannot be
performed. Contact your administrator for details.
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You can check the number of copies and pages
on the [Details] screen for a finished job.

[Job Status] key » [Finished] » select the job
that you want to check » [Details] in the sub
menu » the number of printed pages

The [Paper Size] and [Paper Type] settings on
the printer driver screen may not match the
corresponding settings on the machine.

Even when paper is loaded, the error message is
displayed if the [Paper Size] and [Paper Type]
settings on the printer driver do not match those on
the machine.

Configure the same paper size and type settings
on the machine as those on the printer driver.

[Print] screen » selectjob » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Size] or [Paper Type]

[Auto Selection] may have been set to [OFF] for
the standard tray or feed trays.

Configure [Paper Tray Setting] on the machine so
that auto selection is enabled for the standard tray
or feed tray that you are using.

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » set [Auto Selection] to [ON]

You may not be using paper that is suitable for
printing.

With the inkjet system used by this machine, the
printing quality (especially for color printing) may
vary depending on the paper type. The machine
uses the most suitable color profile setting for each
type of paper when printing. As a result, if the
[Paper Type] setting on the printer driver screen
does not match the type of paper that is loaded in
the machine, the full performance may not be
achieved.

Check the items below.

* When [Paper Type] has been set to [Any] on the
printer driver screen, select the paper type that is
actually in use. For more information, see "Paper
Type" in the "User's Guide".

* Check that the type of paper loaded in the paper
tray matches the paper type specified in [Paper
Tray Setting].

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Type]

The draft function may have been set.

If the draft function is set on the printer driver
screen, the print density decreases because less
ink is used.

To increase the printing density, go to the [Image]
tab and set [Image Quality] to [Standard].

[Printable Area] may have been set to
[Maximum] in the administrator menu.

The inside of the machine may be soiled with ink. It
is recommended that you use the [Standard]
setting, particularly in cases where soiling appears
after printing data containing an image that
extends to the edge of the paper. Contact your
administrator for details.

Correction may be required for data such as
photographic images.

Select the [Gamma Correction] check box in the
[Image] tab on the printer driver screen. Click
[Details] and adjust the brightness and contrast on
the [Gamma Correction] screen.
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The paper type for the standard tray may have
been set to [Envelope].

When the [Thickness] setting in [Paper Type] is set
to [Envelope], duplex printing cannot be performed
using paper from the standard tray, regardless of
the type of paper that is loaded. Configure the
settings according to the paper to be used.

[Print] screen » select job » [Change Setting]
in the sub menu » [Paper Selection] » [Paper
Tray Setting] » [Paper Type] » [Thickness]

You may be trying to output the job with other
than the GL printer driver.

The data may have been printed out or saved
using a printer driver other than the GL printer
driver.

Use the GL printer driver to send the data again.

There may be an image in the barcode area, or
the barcode area definition may be out of
alignment.

In the area specified as the barcode area,
regardless of the color of the original, the base
color is printed in white, and the barcode, text and
illustrations are printed in black.

Check whether the barcode area definition is out of
alignment, or whether any text or illustrations
overlap the 1 mm (3/64") margin around the
barcode.

For more information, see "Barcode Area
Definition" in the "User's Guide".

The [Combine] or [Booklet] settings may not be
configured properly.

Check that the proper page order is specified for
[Combine] or [Booklet] in the [Layout] tab on the
printer driver screen.

The print position cannot be specified for each
odd or even page with the Stamp function.

To print the page numbers in the same position on
odd and even pages, select [Bottom Center] or
[Top Center].

[Margin] may not have been set properly.
Margins are always added around the edges of the
paper. You cannot print without margins.

Check whether the original (image) overlaps with
the specified margins.

[Center alignment] may have been set to off.
Select the [Poster] - [Center alignment] check box
in the [Layout] tab on the printer driver screen.

If the check box is not selected, the image is
formed at the top left corner when the printed
sheets of paper are stuck together.
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It is not necessary to cut off all the margins of
printed paper.

Before cutting the sheets, check the margins which
are necessary for sticking together and which are
used for cutting off.

Example of how to cut off the margins:
Cut off the margins on one of sheets adjacent to
each other only.

The numbers indicating the order of how to
stick the sheets together may not be printed
when using the Poster function.

The divided pages are printed out in order from the
top left page to the bottom right page.

Example of how to arrange the divided pages in
order:

1 2 11213 112|3|4
5|16 |7|8
4|56
3 4 9 (10|11 (12
7/ 8|9
13(14|(15| 16

* When outputting the printouts face up, the
pages are printed in reverse order.
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Troubleshooting for Copying

This section describes how to troubleshoot problems related to copying.

The [Reproduction Size] setting may not have
been set properly.

Set the copy reproduction size to suit the
combination of the original size and paper size.

[Copy] screen » [Reproduction Size]

When creating a booklet, or when performing
[Staple / Punch] or [Staple], the [Auto
Reduction] setting may not have been
configured.

When creating a booklet or using the staple/punch
function, depending on the width of the margin, the
printed surface may be cropped due to not fitting
on the paper. Set [Auto Reduction] to [ON] under
the margin settings to automatically reduce the
printed surface so that it will fit on the paper.

For booklets:

[Copy] screen » [Booklet] » select [Layout
Order] » select [Binding] » [Edit] » set
[Center Margin] » set [Auto Reduction] to [ON]

For staple / punch:

[Copy] screen » [Binding Margin] » set [Auto
Reduction] to [ON]

Duplex copying may have been performed for
an original consisting of different size pages.
When performing duplex copying of mixed-size
originals, simplex (one-sided) copying is performed
if the size of the original to be copied to the front
and back of a sheet of paper is not the same size.

The paper tray setting for the standard tray
may have been set to [Envelope].

When the [Thickness] setting in [Paper Type] is set
to [Envelope], duplex copying cannot be performed
using paper from the standard tray, regardless of
the type of paper that is loaded. Configure the
settings according to the paper to be used.

[Copy] screen P [Paper Selection] » [Paper
Tray Setting] » [Paper Type] » [Thickness]

The settings for copying may not have been set
properly.

Check the original type and image quality.

When the originals are the same in type and
image quality:

Use [ADF Scan & Pause]. You can collectively
copy multiple originals scanned with the same
setting as one job.

Use the ADF only. The platen glass is not
available.

[Copy] screen » [ADF Scan & Pause]

When the originals vary in type and image
quality:

Use [Scan Job Build]. You can collectively copy
multiple originals scanned with different settings as
one job. You can change the copy settings when
the job is being copied.

You can also use the platen glass and the ADF.

[Copy] screen » [Scan Job Build]
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The binding edge may not have been set properly.
The orientation of the paper in the paper tray (standard tray) and the staple binding edge are shown below.

Orientation: Portrait Orientation: Landscape Face Up/Down: Face up Face Up/Down: Face down
{
|
AR AB AB V=84
Staple
Binding o
Edge Staple Position
1 Staple 2 Staples
Left I |
I |
N
1 Staple 2 Staples
Right I I
I |
Left 1 Staple Right 1 Staple 2 Staples
Top I |
I I
—
Paper Paper feed and
transfer AB AB output direction

@ » When the corresponding size of paper is not loaded in the paper tray, a message is displayed.
Follow the on-screen instructions to load the paper.

» For [1 Staple] binding, the staple angle may differ from the images above and the print images on the printer
driver screen, depending on the paper size or orientation.

* When multiple different original sizes are used in the original, the machine automatically rotates the image to
suit the [Binding Edge] setting.
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Troubleshooting for Scanning

This section describes how to troubleshoot problems related to scanning.

You may not have selected [Console] after
touching [Scan] on the [Home1] screen.

The scanned data is not displayed on the RISO
Console if you select [Mail] or [PC] after touching
[Scan], or when the scanned data is saved to
storage. Select [Console] and scan the original
again.

The [Scanning Size] setting may not match the
actual size of the original.

Set [Scanning Size] to the same size as the
original, or set it to [Auto].

[Scan] screen » [Scanning Size]

The [Page Size] and [Reproduction Size]
setting may not have been set properly.

Set [Reproduction Size] to match the combination
of the [Scanning Size] and [Page Size] settings, or
set [Page Size] to the same size as the original.

[Scan] screen » [Page Size]

[Scan] screen » [Reproduction Size]

You may be using the types of originals listed
below.
Color original not identified:

A very lightly colored original

* A very dark or nearly black original

* An almost colorless original (only thin lines of
color, etc.)

Black and white original not identified:

» An original in which the paper itself is not white
(coarse paper, etc.)

Select a color mode other than [Auto], or adjust
[Color/Black Slice Level] in the administrator menu.

[Copy] screen » [Color Mode] » select [Full
Color] / [Black] / [Cyan] / [Magenta] depending
on the purpose

[Scan] screen » [Color Mode] » select [Full
Color] / [Grayscale] / [Black] depending on the
purpose

In the administrator menu, adjust [Color/Black
Slice Level] (1 - 5)

Setting a higher value makes it easier for the
machine to identify color originals. Contact your
administrator for details.

The shared folder created on a computer on the
network may not have been set properly

For Windows, configure the following settings on
the shared folder properties screen.

Check the shared folder name, access
permissions, and user login names in the
[Sharing] and [Security] tabs. Contact your
administrator for details.

ComColor GL Series Troubleshooting Guide



Troubleshooting for Storage and USB

This section describes how to troubleshoot problems related to saving and loading files to and from storage

and USB.

For more information on problems that cannot be resolved using the information here, see "Troubleshooting
for the Printer Driver and Printing" (p.37), "Troubleshooting for Copying" (p.42), and "Troubleshooting for

Scanning" (p.44).

You may not have used the GL printer driver to
save the files in PRN format.

To save a PRN file to a USB flash drive, go to the
[Basic] tab on the printer driver screen and set
[Output] to [Save to USB Drive].

@ * Files that are created and saved using an
application cannot be printed in the format
native to the application.

A USB flash drive may not be in the correct
format.

Use a USB flash drive compatible with Mass
Storage Class and file system format (FAT16,
FAT32, exFAT).

[Manual] may not have been selected for [Paper
Size] in [Paper Selection] - [Paper Tray Setting].
To use irregular sized paper without registering it
as a paper size, enter the size of the paper in
[Manual].

[Storage] - [Load] screen » select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » [Paper Size] »
[Manual]

[USB] - [Load] screen » select folder » [Open]
> select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » [Paper Size] » [Manual]

@ * When [ON] is not selected for [Manual], the
sheet width is set to the width of the paper tray
guide and the length is set to the maximum
length of the relevant tray. When you use the
irregular sized paper, registering the paper size
beforehand will improve the print speed and
paper alignment.

[Auto Selection] may have been set to [OFF] for
the standard tray or feed trays.

Configure [Paper Tray Setting] on the machine so
that auto selection is enabled for the standard tray
or feed tray that you are using.

[Storage] - [Load] screen P select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » set [Auto Selection] to
[ON]

[USB] - [Load] screen » select folder » [Open]
> select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » set [Auto Selection] to [ON]

You may not be using paper that is suitable for
printing.

With the inkjet system used by this machine, the
printing quality (especially for color printing) may
vary depending on the paper type. The machine
uses the most suitable color profile setting for each
type of paper when printing. As a result, if the
[Paper Type] setting does not match the type of
paper that is loaded in the machine, the full
performance may not be achieved. Check the
items below.

» Check that the type of paper loaded in the paper
tray matches the paper type specified in [Paper
Tray Setting].

[Storage] - [Load] screen P select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » [Paper Type]

[USB] - [Load] screen » select folder » [Open]
> select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » [Paper Type]
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The paper type for the standard tray may have
been set to [Envelope].

When the [Thickness] setting in [Paper Type] is set
to [Envelope], duplex printing cannot be performed
using paper from the standard tray, regardless of
the type of paper that is loaded. Configure the
settings according to the paper to be used.

[Storage] - [Load] screen » select folder »
select document » [Change Setting] in the sub
menu for the document » [Paper Selection] »
[Paper Tray Setting] » [Paper Type] »
[Thickness]

[USB] - [Load] screen P> select folder » [Open]
> select document » [Change Setting] in the
sub menu » [Paper Selection] » [Paper Tray
Setting] » [Paper Type] » [Thickness]

The [Reproduction Size] setting may not have
been set properly.

Set the copy reproduction size to suit the
combination of the original size and paper size.

[Storage] - [Save] screen P select folder »
[Save Document] » [Reproduction Size]

When creating a booklet, or when performing
[Staple / Punch] or [Staple], the [Auto
Reduction] setting may not have been
configured.

When creating a booklet or using the staple/punch
function, depending on the width of the margin, the
printed surface may be cropped due to not fitting
on the paper. Set [Auto Reduction] to [ON] under
the margin settings to automatically reduce the
printed surface so that it will fit on the paper.

For booklets:

[Storage] - [Save] screen P select folder »
[Save Document] » [Booklet] » select [Layout
Order] » select [Binding] » [Edit] » set
[Center Margin] » set [Auto Reduction] to [ON]

For staple / punch:

[Storage] - [Save] screen P select folder »
[Save Document] » [Binding Margin] » set
[Auto Reduction] to [ON]

The [Scanning Size] setting may not match the
actual size of the original.

Set [Scanning Size] to the same size as the
original, or set it to [Auto].

[USB] - [Save] screen » select folder » [Save
Document] » [Scanning Size]

The [Page Size] and [Reproduction Size]
setting may not have been set properly.

Set [Reproduction Size] to match the combination
of the [Scanning Size] and [Page Size] settings, or
set [Page Size] to the same size as the original.

[USB] - [Save] screen P select folder » [Save
Document] » [Page Size]

[USB] - [Save] screen P select folder » [Save
Document] » [Reproduction Size]

Select a color mode other than [Auto], or adjust
[Color/Black Slice Level] in the administrator
menu.

[Storage] - [Save] screen P select folder »
[Save Document] » [Color Mode] » select
[Full Color] / [Black] / [Cyan] / [Magenta]
depending on the purpose

[USB] - [Save] screen » select folder » [Save
Document] » [Color Mode] » select [Full
Color] / [Grayscale] / [Black] depending on the
purpose

In the administrator menu, adjust [Color/Black
Slice Level] (1 - 5)

Setting a higher value makes it easier for the
machine to identify color originals. Contact your
administrator for details.

ComColor GL Series Troubleshooting Guide



Troubleshooting for the Multifunction Finisher and Face Down

Finisher

This section describes how to troubleshoot problems related to the optional multifunction finisher and face

down finisher.

» Make sure that the power plug is properly
inserted into the electrical outlet.

» Make sure that the main power switch of the
printer is turned on.

* Press the [Power] key on the operation panel to
restart the machine. If the multifunction finisher
or face down finisher still does not operate,
contact your dealer or authorized service
representative.

The orientation of the loaded original may not
match the [Original Orientation] setting on the
[Staple / Punch] or [Staple] screen.

[Copy] screen » [Staple / Punch] or [Staple] »
set [Original Orientation]

[Storage] - [Save] screen P select folder »
[Save Document] » [Staple / Punch] or [Staple]
> set [Original Orientation]

[Auto Image Rotation] has not been set to [ON].

If it is set to [OFF], the machine cannot staple or
punch the paper at the correct position.

[Copy] screen P [Auto Image Rotation]

[Storage] - [Save] screen » select folder »
[Save Document] » [Auto Image Rotation]

There may be too many sheets for stapling.

* When using the multifunction finisher
The number of sheets that can be stapled are as
follows: 100 sheets for 85 g/m2 (23-Ib bond) A4
(Letter) or smaller paper, and 65 sheets for
paper larger than A4 (Letter).

* When using the face down finisher
The number of sheets that can be stapled are as
follows: 50 sheets for 85 g/m? (23-Ib bond) A4
(Letter) and B5 paper, and 25 sheets for A3 and
B4 (Ledger or Legal) paper.
If staples do not penetrate properly when using the
number of sheets specified above, contact your
dealer or authorized service representative.

Follow the procedure described in "Stapler Jams
(Multifunction Finisher)" (p.48) and "Stapler Jams
(Face Down Finisher)" (p.49) to remove the staple.

The tray position of the face down finisher
(fixed position of » < mark) may not be
aligned properly.

Change the tray position depending on the paper
type or output condition.

To print on many sheets in B5 size or smaller by
offsetting or without sorting, set the fixed position
of the <4 mark to the position shown below.
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Stapler Jams (Multifunction Finisher) 4 Return the staple cartridge to its
original position.

If a staple becomes jammed inside the machine,

follow the procedure below to remove the staple.

Case of the staple cartridge R1

1 Open the cover.

Push the staple cartridge in until it clicks.

5 Close the cover.

2 Hold the handle of the staple
cartridge, and pull it toward you.

Case of the staple cartridge R2/R3

1 Open the cover.

3 Open the staple cartridge cover,
and remove the jammed staple.

Pull the booklet unit out toward
the front.

ACAUTION

Be careful not to injure your fingers when removing
the staple.
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4

5

Hold the cartridge handle, then
slightly lower the staple
cartridge and lift it up.

Open the staple cartridge cover,
and remove the jammed staple.

Be careful not to injure your fingers when removing
the staple.

Hold the cartridge handle, and
install the staple cartridge to its
original position in the booklet
unit.

Be sure to install the staple cartridge to the position
aligned with the A mark of the booklet unit.

Return the booklet unit to its
original position.

J

Stapler Jams (Face Down Finisher)

If a staple becomes jammed inside the machine,
follow the procedure below to remove the staple.

1 Open the staple cover.

Hold the handle of the staple
cartridge, and pull it toward you.
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3

4

Open the staple cartridge cover,
and remove the jammed staple.

ACAUTION

Be careful not to injure your fingers when removing
the staple.

Return the staple cartridge to its
original position.

The Staple Case Has Fallen Out
(Multifunction Finisher)

If the staple case has fallen out of the cartridge
caused by unintentional operation such as the
dropping of cartridge, follow the procedure below
to fix the problem.

1 Open the staple cartridge cover,
: and remove any bent staples.

ACAUTION

Be careful not to injure your fingers when removing
the staple.

If the staple case has been completely separated
from the cartridge caused by the dropping of
cartridge during operation, proceed to step 3 after
following the step above.
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3

Remove the staple case from the
cartridge facing up while
pushing the lever on the rear of
the cartridge in the direction of
the arrow.

&CAUTION

When moving the lever, be careful not to injure your
nails and fingers.

Cut off the portion of the staples
projecting to the outside of the
staple case.

ACAUTION

Be careful not to injure your fingers when removing
the staple.

4 Confirm if there are staples left
in the cartridge.

If there are staples remaining, remove them from
the cartridge facing up while pushing the lever on
the rear of the cartridge in the direction of the arrow.

—

.

{HE

&CAUTION

* When moving the lever, be careful not to injure
your nails and fingers.

 Be careful not to injure your fingers when
removing the staple.

5 Insert the staple case into the
staple cartridge.
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Troubleshooting for the Feed Tray

This section describes precautions for using the feed tray.

You may need to pull out the feed tray to remove
paper jammed at the far end of the feed tray.
There is a spring on the right side of the feed tray.
When pulling the tray out, hold it in the way shown
below, without touching the spring.

9 * To hold the tray with proper balance,
place your right hand on the front cover

part of the tray, and place your left hand
on the left near the back, diagonally
across from your right hand. If you hold
the front part with both hands and pull the
tray, the back end may drop due to the
weight of the tray.

~— How to Load A3 (Ledger) Paper and B4 (Legal) Paper

appropriate hole for the desired paper size.

When using B4 (Legal) paper

Pull the tray until it stops.

Lift the front side of the tray
diagonally upward, and pull out
the tray.

Remove the jammed paper.
Align the white projections on

both sides of the tray with the
rails, and return the tray.

Lift the front side of the tray diagonally upward, and

insert it into the rails. Next, lower the tray to the
horizontal position, and push it in.

Install the paper guides in the proper position for the paper size that you are using. To change the
position of the paper guides, pinch both sides of the paper guide, slide it out and then slide it into the

f
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Troubleshooting for the High Capacity Feeder

This section describes how to troubleshoot problems related to the optional high capacity feeder.

To lower the standard tray, press the standard tray
descent button.

Hold down the standard tray descent button to
lower the standard tray to the position you wish to
lower it to.

@ » The position to which the standard tray is
lowered when paper runs out or when the
standard tray descent button is operated can be
set in the administrator menu.

If a large amount of paper is set at once, the paper
feed guides have trouble adjusting and being
properly set. (Paper is not aligned because paper
is bent or warped.) Load a single pack of paper
and load the rest of the paper after adjusting the
paper feed guides. For more information on
loading a large amount of paper at once, see
"When Setting a Large Amount of Paper at Once"
in the "User's Guide".
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Troubleshooting for the High Capacity Stacker

This section describes how to troubleshoot problems related to the high capacity stacker.

To lower the stacking tray, press the stacking tray
descent button.

By pressing the stacking tray descent button, the
stacking tray will descend to the position at which
the carriage is set (lowermost position).

ﬁ  Pressing the stacking tray descent button while
the stacking tray is descending will stop the
descending of the stacking tray.

» Be sure to press the stacking tray descent
button when both the right and left covers are
closed.

» The position to which the stacking tray is
lowered when a print job is completed or
paused can be set in the administrator menu.

The position to which the stacking tray is
lowered upon completion of a printing job may
be set to [Lower to the carriage] / [Lower to the
specified position].

The stacking tray will not descend if [Do not lower]
is set for [High Capacity Stacker] in the
administrator menu. Contact your administrator for
details.
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Troubleshooting for the IC Card Reader

This section describes how to troubleshoot common problems when using the optional IC card reader.

Another card, such as one that is in the same
carrying case, may be interfering with the IC
card that you are trying to use.

If the cards interfere with one another, you may not
be able to log in using the IC card.

You may not be holding the IC card to the
reader properly.

If the IC card is too far from the IC card reader, the
IC card is not recognized, resulting in
authentication failure.

The USB cable of the IC card reader may not be
properly connected.

If it is not properly connected, you may not be able
to log in using the IC card.

The information on the IC card may not have
been registered on the machine.

* The IC card must be registered by the
administrator in advance. Make sure that the
administrator has registered your IC card.

* The attribute of the external server which is used
for IC card authentication is not set correctly. For
more information on what action to take, contact
your administrator.

Contact your administrator immediately.

The IC card allows the user to log in to the
machine and print documents. If your IC card is
used by an unauthorized third party, the activities
will be recorded under your name. If you notice
that your card is missing, contact your
administrator immediately.
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Other Problems

The front cover can only be opened when an
error such as ink cartridge replacement or
paper jam needs to be resolved.

To open the front cover when an error has not
occurred, press [Front Cover Release].

[Home1] screen » [Maintenance] » [Front
Cover Release]

The administrator may not have properly
configured [Index] in [User Setting].
Contact your administrator.

To delete a job with a PIN code without entering
the PIN code, you need to log in as the
administrator. Contact your administrator to delete
the job.

If you try to print in a network environment where

Wake On LAN communication is not enabled, the
printer does not wake up automatically due to the

sleep level setting configured by the administrator.
Click [Get Printer Info] on the printer driver screen
and configure [MAC Address of the Printer].

Printer driver properties screen » [Environment]
tab P [Get Printer Info]

For more information, see "Wake On LAN" in the
"User's Guide". Otherwise, contact your
administrator.

The IP address of the machine may not have
been entered correctly in the web browser.
Enter the correct IP address. You can check the IP
address of the machine by touching [System Info] -
[Machine Info] from the [Home1] screen.

The machine may be in sleep state.

The sleep level that the administrator configured in
[Power Saving Setting] may not allow you to
activate the RISO Console. Press the [Wake Up]
key to put the machine back into an operational
state, and then activate the RISO Console.

For more information on the power saving setting,
contact your administrator.

The administrator may not have properly
configured the menu to be displayed on the
RISO Console screen using [Console display
item setting].

Contact your administrator.

Press the [Job Status] key on the operation panel.
Touch [Paper Info] on the [Job Status] screen to
display the tray which is feeding paper. When you
want to add paper during printing with the
machine, check the available tray on this screen.

You may not have registered a LDAP server in
[Server Setting]

When only the Kerberos server is registered as a
contact for authentication, you cannot print the jobs
sent from a computer.

Contact your administrator.
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The [Paper Tray Setting] button may be disabled by the administrator when it is not displayed on the
[Paper Selection] screen of the operation panel
Contact your administrator.

There may not be enough available space on the internal SSD of the machine.
To download the firmware, the available space on the internal SSD of the machine must be at least 1 GB.
Delete unnecessary jobs to free up space.

¢

Follow the on-screen instructions to enter the set values.
To ensure optimal printing quality, the machine obtains information from ink cartridges. If the information
cannot be obtained properly, enter the appropriate values on the [Ink Information Input] screen.

A

Reconfigure the ink cartridge information.

* You can check the available space of the internal SSD by touching [System Info] - [Machine Info] from the
[Home1] screen.

« If you replace the ink cartridges or you press the [Power] key on the operation panel to restart the machine, the
set values entered on the [Ink Information Input] screen disappear.

If the [Ink Information Input] screen is displayed, it means that a non-RISO ink cartridge has been installed.
To continue using the non-RISO ink cartridge, enter the appropriate values referring to the following table.

Message

Setting/Description

Set value/Details

Select a temperature
adjustment setting for
the set ink.

To make the optimal printing available, set the
monitor range of the printable temperature for
the ink.

[1] (30 °C - 40 °C)
[2] (30 °C - 45 °C)
[3] (25 °C - 45 °C)
[4] (20 °C - 45 °C)

Select a cleaning
operation for the set
ink.

Set the utmost cleaning cycle for the ink which
will not cause the defective printing.

4

« If the set value exceeds the maximum
number of sheets, the cleaning cycle
setting confirmation screen appears.

[1] (500 to 700 sheets)

[2] (500 to 1500 sheets)
[3] (500 to 3000 sheets)
[4] (500 to 5000 sheets)
[5] (500 to 5000 sheets)

The default values are different
between [4] and [5] while their
selectable ranges are the same.
[4]: 2000 sheets

[5]: 3000 sheets

(
(
E
[5] (20 °C - 40 °C)
(
(
(
(

Set the recommended
Use By date of the ink
cartridge.

Specify the year and month to make the
message appear to indicate that the expiration
date of the ink comes close.

[Month]: 1 - 12
[Year] (last two digits): 00 - 99
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Troubleshooting for the Optional PS Kit

This section describes how to troubleshoot problems related to the PostScript 3 printer driver and printing.

The PDF files may have been saved to a folder

created by the GL printer driver.

» PDF files saved to a folder created by the GL
printer driver are not displayed on the document
list screen of the machine.

« Save PDF files directly to the USB flash drive
without creating a folder, or save them to a folder
that you created beforehand.

Tt Ga)

RISO_IJ RISO_USB_FOLDER_O1

I~

RISO_USB_FOLDER_02
RISO_USB_FOLDER_10

The files inside the blue rectangles shown above
are displayed in the document list.

The files in some file formats such as Word or
Excel are not displayed on the document list
screen.

The [Collate pages] check box may have been
selected in the [Print] dialog box of the
application.

Remove the check mark from [Collate pages]
before printing.

The original data may include multiple paper
sizes.

When printing original data that includes multiple
paper sizes, the paper size of the first page is used
for the remaining pages. As a result, pages that
are a different size than the first page may not be
printed properly, or part of the image may be
missing.

Does the original include high resolution
images?

Printing the original with high resolution images
may not be possible since processing takes too
much time. Recreate the original with images that
are lower in resolution and send the data again. If
printing is still not possible, contact your dealer or
authorized service representative.
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Chapter 3  Maintenance

Replacing the Staple Cartridge

When there are no more staples, printing stops and a message is displayed on the touch panel.
Follow the procedure below to replace the staple cartridge.

Replacing the Staple Cartridge R1 Place a "e“f staple case in the
(Multifunction Finisher) staple cartridge.

g * The staple replacement message may
appear even if there are staples
remaining. Even so, replace the staple
case anyway. The remaining staples can
be used.

1 Open the cover.

5 Return the staple cartridge to its
original position.

2 Hold the handle of the staple
cartridge, and pull it toward you.
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Replacing the Staple Cartridge R2/R3
(Multifunction Finisher)

9 « The staple replacement message may
appear even if there are staples

remaining. Even so, replace the staple
case anyway. The remaining staples
cannot be used. Please take note of this.

1 Open the cover.

Pull out the booklet unit toward the
front.

3 Remove the staple cartridge by
lifting it up after slightly lifting it
down while holding the cartridge
handle.

60

6

Change the orientation of the
cartridge.
/N

S
4@%"#‘
ol

P

Press the area indicated by the
arrow (1) to open the staple
cartridge cover.

Press the area indicated by the
arrow (1) to release the hooks, and
remove the staple case.
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7 Insert the front part of the new 1 Return the booklet unit to its
staple case into the cartridge, and original position.
then insert the back part. :

0 * Align the projection on the front edge
of the staple case with the staple
cartridge.

8 Close the staple cartridge cover.

9 Attach the cartridge to the unit while
holding the cartridge handle.

Align the A marks on the cartridge and booklet unit
when attaching the cartridge.
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Replacing the Staple Cartridge 4 Insert the front part of the new
(Face Down Finisher) staple case into the cartridge, and
then insert the back part.

9 * The staple replacement message may
appear even if there are staples
remaining. Even so, replace the staple
case anyway. The remaining staples can
be used.

1 Open the staple cover.

5 Return the staple cartridge to its
original position.

2 Hold the handle of the staple
cartridge, and pull it toward you.

s

3 Press the areas indicated by the
arrow (1) to release the hooks, and
remove the staple case.
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Cleaning the Punching Box

When the punching box becomes full of punching trash, printing stops and a message appears on the touch
panel. Use the following procedure to remove the punching box and dispose of the punching trash.

9 * When removing the punching box, be sure to dispose of all punching trash. If punching trash remains
inside the punching box, the punching box may become full before the message for replacement
appears, causing a malfunction.
* Be sure to perform this task with the power of the machine turned ON. If the machine is not turned
ON, the machine will not recognize that the punching box is empty. When the machine is in the sleep
mode, press the [Wake Up] key on the operation panel before use.

Disposing of the Punching Trash 4 Return the punching box back to its
original position.

1 Open the cover.

2 Remove the punching box by
pulling it forward.

3 Discard all of punching trash.
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Cleaning the Staple Waste Box

When the staple waste box becomes full of staple waste, printing stops and a message appears on the touch
panel. Use the following procedure to remove the staple waste box and replace to the new one.

Disposing of the Staple Waste R5 5 Attach the new staple waste box.

1 Open the cover.

Release the lock by moving the lock
lever to the unlock icon (open)
position on the left.

3 Remove the staple waste box.

A\ I

4 Dispose of the staple waste box.
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Simple Questions

A message indicating that one ink cartridge must be replaced is displayed. Can |
continue printing?

No, you cannot. Printing resumes after the empty ink cartridge has been replaced.
The job data will not be lost when printing is stopped because of an empty ink cartridge.
Can | load different size originals together into the ADF?

You can scan different size originals together which have one side of equivalent length. Set

[Mixed Size Original] to [ON]. For more information, see "Mixed Size Original" in the "User's
Guide".

Orientation of original

when loading in ADF &= ABC

ABC

How do | turn off the operation sounds?

The confirmation and error sounds can be turned on or off in the [Beep Sound] setting in the
administrator menu.

Contact your administrator.

How should the original be loaded when using [Top Side Up] and [Top Side Left] in
the [Original Orientation] setting?

[Top Side Up] [Top Side Left]

ABC

[ABC

E/E/

Load the original in the Load the original with
same orientation as if the top of the page on
you were reading it. the left side.

The machine logged me out even though | did not perform any action.

The [Auto Logout Time] setting has been configured for [Login Setting] in the administrator
menu. [Auto Logout Time] can be set to between 10 and 3600 seconds.
Contact your administrator.
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| have to wait before using the machine, because it is always in sleep state when |
try to use it.

The machine automatically enters sleep state after a fixed period (1 to 60 minutes).
To decrease the transition time from sleep state to ready state, set [Power Consumption (in
Sleep)] to [Standard] for [Power Saving Setting] in the administrator menu.

What is the [Offset Output] setting?

This function enables the machine to stack each set of printed documents slightly apart from
each other when they are output, making them easy to separate.

This setting is available when the optional multifunction finisher, face down finisher, or high
capacity stacker is connected.

Can | print without my IC card?
Certain [Login Method] settings configured by the administrator may allow you to log in using an
IC card or PIN code. Depending on the setting, you may be able to log in without the IC card if

you enter the PIN code.
Contact your administrator.

Can | print without a margin?

No, you cannot. Printouts always have a blank margin, regardless of the data size.

What is the Storage function?
The Storage function enables scanned originals or print data sent from a computer to be saved

to the internal SSD of this machine. This function is useful for saving documents that are printed
frequently.

How can | check the current status of a job, or the details of completed jobs?

Press the [Job Status] key on the operation panel. The [Job Status] screen is displayed. You
can check the details of jobs that are being processed, idle jobs, and completed jobs.

How can | check the IP address of the machine and the version of the firmware?

You can check them by touching [System Info] - [Machine Info] from the [Home1] screen.

How can | reduce ink setoff?

Set [Image Quality] to [CMY Print] in the [Image] tab on the printer driver screen.
The fixation of ink will improve and help prevent ink from transferring onto adjacent sheets.

068-36008-004
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